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Note to all Studio Hawk Users: This manual has been developed to allow you to find 
information quickly and easily to make The Studio Hawk a valuable tool to "beginners" and 
"professionals".  Due to the detailed nature of the information, the manual has been 
through many revisions, and we feel that it is still a "work in progress". Therefore, if you 
find any mistakes (spelling or otherwise), please send your comments to 
Support@IntrinsicNet.com. For your significant contribution toward the improvement of 
this manual, we will send you a Free Plus SIne T-shirt (while supplies last!).  
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Chapter 1 
 
The Studio Hawk Overview 
 

  

The Studio Hawk.8 was developed to provide a low-cost solution to monitoring audio and EAS 
receivers at a studio, and for efficient communication of problems via email, text messaging, and 
signaling devices. The base system includes Studio Hawk software and hardware to monitor 8 
status channels, 8 analog channels, and 8 relays. The Studio Hawk.8 records EAS data (transmitted 
and received), and can be expanded to monitor up to a total of 6 EAS receivers. 

  

Includes Studio Hawk.8 Software and Hardware 
· Monitors 8 status channels, 8 analog channels and 8 relays 
· Emails or text messages of alarms 
· Multiple contacts for each alarm with delays between text messages 
· Dead air report via email 
· EAS receiver monitoring 
Records EAS data (transmitted and received) 
Filters EAS alerts that can be emailed or sent via text message 



License 

  
"The Studio Hawk" is copyright (c) 2008 IntrinsicNet. All rights reserved and are 
trademarks of Olen Booth.  
 
IMPORTANT - READ CAREFULLY  
This license statement and limited warranty constitutes a legal agreement ("License Agreement") between you ("Licensee", either as an 
individual or a single entity) and IntrinsicNet. ("Licensor"), sole worldwide publisher of the software product "The Studio Hawk" 
("Software") of which IntrinsicNet is the copyright holder. BY INSTALLING, COPYING, OR OTHERWISE USING THE SOFTWARE, 
YOU AGREE TO BE BOUND BY ALL OF THE TERMS AND CONDITIONS OF THE LICENSE AGREEMENT.  
Upon your acceptance of the terms and conditions of the License Agreement, Olen Booth grants you the right to use the Software in the 
manner provided below. If you do not accept the terms and conditions of the License Agreement, you are to promptly delete each and 
any copy of the Software from your computer(s). The Vendor reserves the right to license the same Software to other individuals or 
entities under a different license agreement. After accepting this license agreement, the Licensee is permitted to use the Software 
under the terms of this agreement for no more than thirty (30) days, and for evaluation purposes only, without payment to the Vendor.  
For this purpose, the Vendor provides a special free trial version of the Software that can be freely downloaded from the Vendor's web 
site. If the Licensee wishes to use the software for more than thirty (30) days and/or for purposes other than evaluating the Software, 
the Licensee must purchase a single user license or a multi-user license from the  
Vendor. This license bears the name of the licensed person or entity and is not transferable to any other party. Pricing and availability is 
subject to change without prior notice. The Licensee can consult the most recent  
pricing information at http://www.PlusSine.com If a single user license was bought, the Licensee has the option of installing the 
Software on a single machine possibly used by one or more persons. Installing the Software on a network server, is not permitted.  
The Licensee has the right to place an additional copy of the Software on a removable medium for backup purposes to protect the 
investment made. Technical support is available for the thirty (30) days directly from the Vendor at no additional charge. When 
encountering problems, the Licensee must first visit the Vendor's web site at http://www.PlusSine.com/ and  
read the information presented there to make sure the question or problem is not already answered there. If not, the licensee may write 
to support@IntrinsicNet.com with his question in the English language.  
 
 
The Software is provided "as is". In no event shall the Vendor or any of his affiliates be liable for any consequential, special, incidental 
or indirect damages of any kind arising out of the delivery, performance or use of this Software, to the maximum extent permitted by 
applicable law. While the Software has been developed with great care, it is not possible to warrant that the Software is error free. The 
Software is not designed or intended to be used in any activity that may cause personal injury, death or any other severe damage or 
loss. When errors are found in the Software, the Vendor will release a new version of the Software that no longer contains those errors 
within a reasonable amount of time after the Vendor is given an accurate description of those errors. The amount of time considered 
reasonable will depend on the complexity and severity of the errors.  
The Vendor will mention the release at http://www.TheStudioHawk.com and, at the Vendor's option, directly contact the Licensee to 
announce the new release. The Licensee can then, at their option, upgrade to the latest version or continue to use the older version the 
Licensee already has. In either case, no payment to the Vendor is required. In the latter case, the Licensee will no longer be entitled to 
technical support until the Licensee has upgraded to the latest version. The Vendor reserves the right to charge an upgrade fee in the 
case of major new enhancements or additions to the Software. This major new version will then start a new version line which will use 
version numbers clearly distinguishable from the old version line. The Licensee has no obligation to upgrade to the new version line and 
the Vendor will continue to make available the latest version of the previous version line and release new versions in the old version line 
in the case errors are still found, and provide technical support for it.  
You must not attempt to reverse compile, modify, translate or disassemble the Software in whole or in part. You must not run the 
Software under a debugger or similar tool allowing you to inspect the inner workings of the  
Software. The Software remains the exclusive property of the Vendor. Any Licensee which fully complies with the terms in this license 
agreement may use it according to the terms of this license agreement. You must not give copies of the Software or your license key to 
other persons or entities. You must not transfer the Software or your license key to another person or entity. You must also take 
reasonable steps to prevent any third party from copying the software from one of your machines without your permission.  
You may distribute the evaluation version of the Software that is available for public download at http://www.PlusSine.com, on the 
condition that you do this by making identical copies of the downloaded file(s). Public download means any file that can be downloaded 
by browsing to http://www.PlusSine.com and navigating through the links visible on the page, without the use of any password or 
identification that you may type in or that may be automatically supplied by your browser if you have typed it in before. You must not 
ask payment for the act of distributing the evaluation version of the Software or for the evaluation version itself. You may ask a 
reasonable contribution to cover your expenses in material, shipping and communication costs. You must make license agreement in 
order to evaluate it, and make payment in order to fully use the Software. You must not distribute the evaluation version by making it 
part of a larger package, unless that package is a collection of evaluation software and other software that does not require payment.  
 
The Vendor reserves the right to revoke your license if you violate any or all of the terms of this license agreement, without prior notice.  
 
 



Chapter 2 

Database Navigation 

Button Purpose  
 

 
First  Sets the current record to the first record in the data set, disables the First and Prior 
buttons, and enables the Next  
and Last buttons if they are disabled.  

  
Prior Sets the current record to the previous record and enables the Last and Next 
buttons if they are disabled.   

  
Next Sets the current record to the next record and enables the First and Prior buttons if 
they are disabled.  

  
Last  Sets the current record to the last record in the data set, disables the Last and Next 
buttons, and enables the First and Prior buttons if they are disabled.  

  
Insert Inserts a new record before the current record, and sets the data set into Insert and 
Edit modes.  

  
Delete Deletes the current record and makes the next record the current record.  

  
Edit Puts the data set into Edit mode so that the current record can be modified.  

 
Post Writes changes in the current record to the database.  

  
Cancel Cancels edits to the current record, restores the record display to its condition 
prior to editing, and turns off  
Insert and Edit modes if they are active.  

 
Refresh Refreshes the buffered data in the associated data set.  



Chapter 3 
 

 
Installing the USB-1208LS  
 
 
What comes with your USB-1208LS shipment?  
As you unpack your USB-1208LS, verify that the following components are included.  
 
Hardware  
 
� USB-1208LS  

 
 
� USB cable (2 meter length)  

 
Additional documentation  
In addition to this hardware user’s guide, you should also receive the Quick Start Guide (available in PDF at 
www.mccdaq.com/PDFmanuals/DAQ-Software-Quick-Start.pdf). This booklet supplies a brief description of the 
software you received with your USB-1208LS and information regarding installation of that software. Please read this 
booklet completely before installing any software or hardware.  
 
Unpacking the USB-1208LS  
As with any electronic device, you should take care while handling to avoid damage from static electricity. Before 
removing the USB-1208LS from its packaging, ground yourself using a wrist strap or by simply touching the computer 
chassis or other grounded object to eliminate any stored static charge.  
If any components are missing or damaged, notify Measurement Computing Corporation immediately by phone, fax, or 
e-mail:  
 
� Phone: 508-946-5100 and follow the instructions for reaching Tech Support.  
 
� Fax: 508-946-9500 to the attention of Tech Support  
 
� Email: techsupport@mccdaq.com  

 
2-1 USB-1208LS User’s Guide Installing the USB-1208LS  
 
USB-1208LS Installation 

 



Installing the software  
Refer to the Quick Start Guide for instructions on installing the software on the Measurement Computing Data 
Acquisition Software CD. This booklet is available in PDF at www.mccdaq.com/PDFmanuals/DAQ-Software-Quick-
Start.pdf.  
Installing the hardware  
Be sure you are using the latest system software  
Before you connect the USB-1208LS, make sure that you are using the latest versions of the USB drivers.  
Before installing the USB-1208LS, download and install the latest Microsoft Windows updates. In particular, when 
using Windows XP, make sure you have XP Hotfix KB822603 installed. This update is intended to address a serious 
error in Usbport.sys when you operate a USB device. You can run Windows Update or download the update from 
www.microsoft.com/downloads/details.aspx?familyid=733dd867-56a0-4956-b7fe-e85b688b7f86&displaylang=en. For 
more information, refer to the Microsoft Knowledge Base article "Availability of the Windows XP SP1 USB 1.1 and 
2.0 update." This article is available at support.microsoft.com/?kbid=822603.  
To connect the USB-1208LS to your system, turn your computer on, and connect the USB cable to a USB port on your 
computer or to an external USB hub that is connected to your computer. The USB cable provides power and 
communication to the USB-1208LS.  
When you connect the USB-1208LS for the first time, a Found New Hardware popup balloon (Windows XP) or dialog 
(other Windows versions) opens as the USB-1208LS is detected by your computer.  
Another Found New Hardware balloon or dialog opens after the first closes that identifies the USB-1208LS as a USB 
Human Interface Device.  
When this balloon or dialog closes, the installation is complete. The LED on the USB-1208LS should flash and then 
remain lit. This indicates that communication is established between the USB-1208LS and your computer.  
 

Caution! Do not disconnect any device from the USB bus while the computer is communicating with the USB-
1208LS, or you may lose data and/or your ability to communicate with the USB-1208LS.  

 
If the LED turns off  
If the LED is illuminated but then turns off, the computer has lost communication with the USB-1208LS. To restore 
communication, disconnect the USB cable from the computer, and then reconnect it. This should restore 
communication, and the LED should turn back on.  

 
4-Channel Balanced Audio (Status & Relays)   

Pin  Signal Name  Pin  Signal Name  
1  Ch 1 + 21  Relay 0 Out Bit 0  



2  Ch 1 -  22  Relay 1 Out Bit 1 
3  Ch 1 GND  23  Relay 2 Out Bit 2 
4  Ch 2 +  24  Relay 3 Out Bit 3 
5  Ch 2 -  25  Relay 4 Out Bit 4 
6  Ch 2 GND  26  Relay 5 Out Bit 5 
7  Ch 3 +  27  Relay 6 Out Bit 6 
8  Ch 3 -  28  Relay 7 Out Bit 7 
9  Ch 3 GND  29  GND  
10  Ch 4 +  30  PC+5V  
11  Ch 4 -  31  GND  
12  Ch 4 GND  32  Status 1 input  
13  Not Used  33  Status 2 input 
14  Not Used  34  Status 3 input 
15  GND Not Used 35  Status 4 input 
16  CAL  36  Status 5 input 
17  GND  37  Status 6 input 
18  Not Used 38  Status 7 input 
19  GND  39  Status 8 input 
20  Not Used 40  GND  
    

8-Channel Unbalanced Audio (Status & Relays)   
Pin  Signal Name  Pin  Signal Name  
1  Ch 1 + 21  Relay 0 Out Bit 0  
2  Ch 2 +  22  Relay 1 Out Bit 1 
3  Ch 1,2 GND  23  Relay 2 Out Bit 2 
4  Ch 3 +  24  Relay 3 Out Bit 3 
5  Ch 4 +  25  Relay 4 Out Bit 4 
6  Ch 3,4 GND  26  Relay 5 Out Bit 5 
7  Ch 5 +  27  Relay 6 Out Bit 6 
8  Ch 6 + 28  Relay 7 Out Bit 7 
9  Ch 5,6 GND  29  GND  
10  Ch 7 +  30  PC+5V  
11  Ch 8 +  31  GND  
12  Ch 7,8 GND  32  Status 1 input  
13  Not Used  33  Status 2 input 
14  Not Used  34  Status 3 input 
15  GND Not Used 35  Status 4 input 
16  CAL  36  Status 5 input 
17  GND  37  Status 6 input 
18  Not Used 38  Status 7 input 
19  GND  39  Status 8 input 
20  Not Used 40  GND  
    

 
 
Notes. 
 
1. DO NOT CONNECT ANY RELAY DIRECTLY TO THE RELAY OUTPUT OF THE 1208LS PINS 21-28 THAT 
DRAW OVER 2.5 ma. You must use buffers to drive relays. 
 
2. Audio inputs need to be terminated.  If you are bridging another device that has termination then you are ok.  If not 
you need to place a termination resistor across the input.  Most broadcast audio equipment has an output impedance is 
600 ohm. Most consumer audio equipment has an output impedance is 10k. Connect resistors as listed below. 
 



3. The audio connected to the 1208SL is sampled and then converted to an approximate DC value. The meters 
displayed on the main page of The Studio Hawk are an approximation of the audio input. It is used to determine if the 
station’s audio source is present or not. The values displayed are not an accurate representation of the audio’s DB level. 
 
Connect a resistor between the pins listed below. Most common values are 600 ohms for broadcast equipment and 10k 
ohms for unbalanced consumer grade equipment. Only install resistors if the equipment is not terminated by another 
peace of equipment. 
 

4 Channel Mode Pins  

1  Pin 1 to Pin 2 

2  Pin 4 to Pin 5 

3  Pin 7 to Pin 8 

4  Pin 10 to Pin 11 

  

8 Channel Mode   

1 Pin 1 to Pin 3 

2 Pin 2 to Pin 3 

3 Pin 4 to Pin 6 

4 Pin 5 to Pin 6 

5 Pin 7 to Pin 9 

6 Pin 8 to Pin 9 

7 Pin 10 to Pin 12 

8 Pin 11 to Pin 12 

  
  
  

 



  

Chapter 4 

The Studio Hawk Main Screen 
 

  
 
Suspend Paging  

By checking this box, The Studio Hawk will suspend text messaging and emailing.  
When not checked, The Studio Hawk will start messaging and emailing.  

Trend (Strip) Chart Button  
A trend (strip) chart is a data acquisition tool used to generate a plot, graph or other visualization of data 
versus time. A trend chart is used to monitor either analog or status channels in real time. As many as 8 
channels can be recorded at one time. The charts can show the time relationship between the channels.  
 



 

 

 

Alarm Tab 
 

 
  

Create New Alarm Table  
Used to close the current alarm table and create a new one. Used if an alarm table is corrupted or is 
out of date.  

Alarm Date  
The date that the alarm occurred.  

Time Alarm Cleared  
The time the alarm was cleared, or the time the alarm was truncated on startup.  

Label  
The common name or text information about an alarm. (i.e. what channel, what date and time, above 
or below what limit, and for how long)  

Current Database  
The name of the current database in which the alarms are being stored. When the alarm database gets 
too large to handle, The Studio Hawk will automatically close the database and create a new one. The 
alarm database files will be deleted based on the dates stated in the system setup.  

 



 
 

 

Chapter 5 

Analog Channel Setup 
 
Use the following pull down menu: Edit > Analog 

 
 
 
  
Analog Label  
The Analog Label is the text that will be displayed on the meter and used as related to other functions. It is the title of 
the analog channel.  
Analog Unit  
The Analog Unit is the unit of measurement for a channel 
Use Alarm Relay 
If this box is selected and a signaling device is attached to The Studio Hawk, then this channel will activate an audible 
or visible alarm. For more information on signaling, see Setting up Signaling Devices Alarm Relay 
Use Text Message 
If this box is selected, the message sent will be the text entered in the “Paging Message” edit box. 



If this box is not selected, the alarm will show the level at the time of the alarm (i.e. Audio was logged at –70 db 
below limit of –30 db) 
Show 
If this box is selected, this meter will be displayed on The Studio Hawk main page. 
Note: regardless if the meter is shown or not, the alarm and meter will be active unless both are unchecked. 
Paging Message 
The message that will be sent (text or email), if this channel goes in alarm. 
Use Alarm Relay 
If this box is checked and a signaling device is attached to The Studio Hawk, then this channel will activate an 
audible or visible alarm. 

Alarm Logging  
 
Active  
When checked the logging function is enabled.  
Upper Limit  
If the Analog Channel exceeds the selected value for the selected time set in the Log Delay, a log entry will be made in 
the Alarm List.  
Lower Limit  
If the Analog Channel drops below the selected value for the selected time set in the Log Delay, a log entry will be 
made in the Alarm List. 
 No Upper Limit  
Select the No Upper Limit button, and there will be no upper limit for the log. When you enter a value in the Upper 
Limit box, logging will be restarted.  
No Lower Limit  
Select the No Lower Limit button, and there will be no lower limit for the log. When you enter a value in the Lower 
Limit box, logging will be restarted.  
Alarm Log Delay  
The amount of time in seconds you want Studio Hawk to wait before making an alarm log entry.  

Paging  
 
Active  
When selected the Paging function is enabled.  
Upper Page  
If the Analog Channel exceeds the set value for the amount of time set in the Paging Delay, a page will be sent. 
 Lower Page  
If the Analog Channel drops below the set value for the amount of time set in the Paging Delay, a page will be sent. 
 No Upper Limit  
Select the No Upper Limit button, and there will be no upper limit for the paging. When you enter a value in the Upper 
Limit box the paging will be restarted. 
 No Lower Limit  
Select the No Lower Limit button, and there will be no lower limit for the paging. When you enter a value in the Upper 
Limit box the paging will be restarted.  
Paging Group  
A list of pagers, cell phones or email accounts to notify if an alarm or event occurs. 
 Page Delay  
The amount of time in seconds you want The Studio Hawk to wait before paging.  
Attempts  



The number of times you want The Studio Hawk to send pages on this alarm. The paging will stop when one of the 
following is achieved: 
 
1. The alarm is cleared.  
2. The suspend paging box is checked.  
3. All of the pages have been sent.  
 
Time Between Pages  
The amount of time The Studio Hawk will wait in minutes between pages. This will allow someone enough time to 
correct the problem before the next page is sent. 

 

Others  
Normal Value  
The normal input value of a channel.  Used to calculate quick limits and to get into the simulate mode.  If the audio 
level is normally –5 db, then you input a value of -5. This is used to set the value in the simulate mode.  
Calibration Constant  
This is the value created when the gain slider is adjusted.  It is used to convert the input voltage to a usable value to be 
displayed by the metering system.  
Analog Grid 
A spreadsheet view of the analog records . You can click on the row and edit the data or use this page to select the 
record you would like to edit. Once the record is selected, click the Analog setup tab to edit the data. 
  

Status Channel Setup 
 
Use the following pull down menu: Edit > Status 

 
 
  



Status Grid  
A grid or spreadsheet view of the status records. You can click on a row and edit the data, or you can use this page to 
select the record you would like to edit then click the Status Setup tab to edit the data.  
Status Label  
This label is the text that will be displayed on the Status Indicators and used as related to other functions.  
On State  
The label that will be displayed when the Status Input is low.  
Off State  
The label that will be displayed when the Status Input is high.  
Device Bit  
This is the input of a device.  (0 –7) 
Paging Message 
The message that will be sent (text or email) if this channel goes in alarm. 
Is this an EAS receiver? 
If checked, The Studio Hawk will look for an incoming EAS and report it as an alarm.  The EAS receiver monitored is 
determined by the bit.  
Bit 1= EAS receiver 1 
Bit 2= EAS receiver 2, and so on. 

Logging  
Active  

When this is selected, the logging function will be enabled.  
Alarm State  

The state of a status channel that will cause an alarm to be logged or a page to be sent.  
Log Delay  

The amount of time in seconds Studio Hawk will wait before it will make a log entry in the Alarm 
List.  

Paging  
Active  

When this is selected the paging function will be enabled. 
Paging Group  

A list of pagers, cell phones or email accounts to notify if an alarm or event occurs. See Edit/setup 
Paging Sequence for more details.  

Log Delay  
The amount of time in seconds The Studio Hawk will wait before sending a page. 

Attempts  
The number of times The Studio Hawk will page on this alarm. The paging will stop when one of the 
following is achieved: 

 
   1. The alarm is cleared.  

2. The suspend paging box is checked.  
3. All of the pages have been sent.  

 
Time Between Pages  

The amount of time in minutes The Studio Hawk will wait between pages. This will allow someone 
enough time to correct the problem before another page is sent. 

Use Alarm Relay  
If this box is selected and a signaling device is attached to The Studio Hawk, then this channel will 
activate an audible or visible alarm. For more information on signaling, see Setting up Signaling 
Devices Alarm Relay. 



 
  

 

Relays Setup 
 
 
Use the following pull down menus: Edit > Relay  

 
 
 
Relay Name  

Enter the name of the relay that will be displayed on the buttons.  
Relay Duration  

Enter the amount of time in milliseconds that the relay will be engaged.  
Button Label  

Enter the name that will be placed on the button on the Button Box page or any Tab  
Relay Type:  

Pulse :Sets the output high for the amount of time defined in Duration.  
Close :Sets the output high and is held there until a Open or Pulse is sent.  
Open :Sets the output low and is held they’re until a Close or Pulse is sent.   

Show 
 If selected, this relay will be shown on The Studio Hawk main page.  
Confirmation  

If this box is checked a confirmation box will appear when the user presses a button related to this relay. This 
is used to prevent accidental activation of a critical relay 
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Contacts 
 
How To Create A Contact 
 
Path: Edit > Messaging and Paging > Contact Info.  

 
 
  
Name  
The name of the person receiving the email or text message.  
Address  
The address of the Text or Email (i.e. 6625551212@Cell phone.com)  
CC  
(Carbon Copy) A second copy of this message/email will be sent to the address entered 
Email or Text Message 
If set to Text Messaging, then a short message is sent and the alarm is placed in the subject line. 
Edit Paging Groups Button 
Once you have created an email account, you must place the contact in a paging group to be used.  
 
 



.  
 

Email Lists  
 

 
 
Note: a page refers to a pager, text message, or email.  
  
Group Name  
A common name for the paging group (i.e. Off-The-Air, Program Directors, etc.)  
This is an example of the paging group set up to receive notification when the analog channel is in alarm:  
  
This is the paging group for this example.  
 
Analog Paging Setup for Channel #1 (WKOR-FM) 

 
  
At 09:00:00 a.m. the WKOR audio dropped below  -16 DB for 30 seconds 
 



1. At 09:00:30 a.m. the PD for WKOR-FM (1st) is sent a page, text message or email. (page 1 )  
2. When The Studio Hawk finds a None (2nd), a pause is inserted.  
3. At 09:05:30, if the WKOR-FM audio is still out of limits, the PD for WKOR-FM (3rd) will be sent a page, text 
message or email (attempts are made every 5 minutes as set up in Page Delay).  
4. Another None (4th) is found, and again The Studio Hawk will wait.  
5. At 09:10:30 if the analog channel is still out of limits, the General Manager (5th) and CE (6th) will be sent a page, 
text message or email.  
6. Another None (9) is found, and again The Studio Hawk will wait.  
7. At this point only 4 of 5 pages, emails, or text messages have been sent, and only 4 contacts are setup in the page 
group, so The Studio Hawk will start back at the top of the list.  
8. At 09:15:30 a.m. the PD for WKOR-FM will be sent a page, text message or  
email again.  
  
Paging can be halted by checking the Suspend Paging button box or if the alarm is cleared.  
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Trend Charts 
 

 
A trend (strip) chart is a data acquisition tool used to generate a plot, graph or other visualization of data versus time. A 
trend chart is used to monitor either analog or status channels in real time. As many as 8 channels can be recorded at 
one time.  The charts can show the time relationship between the channels. Even though the strip chart can only record 
8 channels at a time, The Studio Hawk keeps a continuous log of all analog and status channels.  
You can select and change the channels that you want to visualize on the chart at any time.  
The Trend View tool is used to view Trend Chart data for a previous date. The Trend Chart files are closed at midnight. 
The files are then stored in the "C:\stations\Studio\charts\" directory. There is a data file with the extension ".TRD" and 
a Setup file with the extension ".INI".  For example, for the date of Jan 05 2008, the files would be Jan0508.TRD and 
Jan0508.INI. The files are purged every night. Files will remain on the hard drive until after the date set in the system 
setup. The items recorded on the Trend Chart are set up by pressing the "Chart Setup" button at the top right side of the 
Trend Chart.  
  
x1000 
 Back Move the chart back 1000 samples (if your Data write rate = 1 sample/second this will be 16 minutes and 40 
seconds) 
 X100 Back  
Moves the chart back 100 samples (if your Data write rate = 1 sample/second this will be 1 minute and 40 seconds) 
 X10 Back  
Moves the chart back 10 samples (if your Data write rate = 1 sample/second this will be 10 seconds) X1 back Moves 
the chart back 1 sample (if your Data write rate  
= 1 sample/second this will be 1 second) 



 X1 
 Forward Moves the chart forward 1 samples (if your Data write rate = 1 sample/second this will be 1 second) X10 
Forward Moves the chart forward 10 samples (if your Data write rate = 1 sample/second this will be 10 seconds)  
X100 Forward  
Moves the chart forward 100 samples (if your Data write rate = 1 sample/second this will be 1 minute and 40 seconds) 
X1000 Forward Moves the  
chart forward 1000 samples (if your Data write rate = 1 sample/second this will be 16 minutes and 40 seconds)  
Flow  
If Flow is checked, the graph will move forward with time. If Flow is not checked, the chart will not advance.  
Notes: Use the unchecked mode if you would like to view a single point in time without the chart moving forward.  
Save  
Used to save the chart to a file name other than the default. This can be used to export a table to a memory stick.  
Note: The Trend Chart files are automatically updated on the hard drive to insure minimum data loss in the event of a 
lockup or a UPS failure.  
Delete  
Deletes the data displayed on the current screen and purges the current trend file (current.trd) on the hard drive.  
Left Scale  
Used to set the left scale to the range of the channel selected. 
Right Scale 
 Used to set the right scale to the range of the channel selected. Left Scale Visible Used to turn the left scale on and  
off. Right Scale Visible Used to turn on and off the right scale. Grid Y Steps Change the spacing of the Y grid (located 
on the left and right side of the graph).  
Fill Channel  
If selected (zero means fill no channel). The selected channel will be filled under the curve.  
Value at Cursor  
The value of every channel logged by the Trend Chart will be shown at the point you select on the graph (noted by the 
white horizontal line).  
Visible Channels  
This allows you to select the channels to be displayed. The channels that are not selected will still be recorded but not 
displayed.  This allows you to minimize the clutter on the screen Up Button Moves the center point up. Down Button 
Moves the center point down.  
Zoom In  
Expands the vertical gain.  
Zoom Out  
Contracts the vertical gain. 
 Reset Button  
Resets the zoom and the center point to the original defaults.  
Setup Button  
Jumps to the Trend Chart Setup Screen.  
Date  
Displays the current date in the lower part of the graph.  
Time  
Displays the time in the lower part of the graph.  
Total Number of Records  
The total number of records recorded in the current.trd file. (information only)  
Start Time  
Shows the start time of the current trend file (current.trd).  
Stop Time  
Shows the stop time of the current trend file (current.trd).  
 



 
Trend Setup  
 

 
  
Chart Item  
Select the items to record and view on the Trend Chart. Status Use the Status check box if you want to display a status 
(on/off) item instead of an analog item.  
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Report Generator  
  
Add Alarms  
If checked, the alarm list will be included when printing or emailing logs.  
Report Name  
The name for the report. Used to identify the report when setting up a timed event to email or print a log.  
Header 1-3  
Three lines that will be printed on the top of a report.(i.e station, call letters, city, state , and report type).  
Intervals  
The amount of time in seconds between readings that will be recorded on reports. The old FCC logs were recorded at 
30 minute intervals. This number cannot be smaller than 1 second.  
Time Frame  

Today  
Today's log (from midnight last night until the current time) Yesterday From midnight (00:00:00) two 
nights ago until midnight( 00:00:00) last night. Last Week From Sunday morning at midnight 
(00:00:00) to the following Sunday morning at midnight  (00:00:00).  

Custom (date)  
User defined start and ending date.  

  Custom (time)  
User defined start and ending time.   

Report List 
 A list of reports you have created. Click on the report name, and that report will be displayed for editing or reviewing. 
Report Items  
Type  
Select the items to be reported (status or analog). Analog or Status Report The type of items to display for selection. 
Use the Status check box if you want to report a status (on/off) item instead of an analog item.  
Alarm Report  
Used to view or print an report of alarms. An Alarm Report is a report generated from the alarm list. This report shows 
which channel was in alarm and the duration of the alarm. Save Report Used to save the current report to disk. Reports 
are stored at  
'C:\stations\studio\logs\report'. 
Custom Time  
 Allows you to select the start and stop time for a report.  
Custom Date  
 Allows you to pick a custom start and stop date for a report.  



 

Chapter 9 
Timed Events 
 
Timed Event Tab 
An event that is executed based on time. There are several different events that can be used. The events can be run once 
an hour, day or week. An event can be stopped by deactivating the event. It is not necessary to delete the event, just 
deactivate it. 

 
 
Timed event tab is used to show the current events that are running and the time the next event will 
run. 
 
Next Event 00:00:00 
Shows the amount of time remaining before the next event is executed. 
Rebuild 
Used to force a rebuild of the time sequence database. Use this after edit, deleting, or adding an event. 
Do Selected Event Now 
By highlighting an event and pressing this button, you can force an event to occur without waiting for its predefined 
time. 
Edit timed event 
You can use this button to jump to the Edit Event Page without having to go through the menu, Edit > Timed -> 
 
 
Common to All Timed Events 
 
Name 
Common name to be used for the timed event. 
Time 
Specified time the event will be executed. 
Active 
Check to allow this timed event to be executed. 
Time Type 

Everyday 
This event will be executed once a day. 
Specific Day of Week 
Any day can be selected to run the event. 
Weekdays 
This event will only execute on weekdays, Monday through Friday. 



Weekends 
This event will only execute on weekends, Saturday and Sunday. 
 

Types of Timed Events 
 

Relay 
Mute Limits and Paging 
Un Mute Limits And Paging 
Print or Email Report(s) 
Checking In 
 
Relay Timed Event 
 

  
 
Use this event to activate a relay on a timed event. For example, you can activate a Aux transmitter once a week by 
setting up the following two events: 
 
1st event: 
Event Type: Relay 
Active: Yes 
Timed type: Sunday 
Time: 09:00:00 PM 
Relay: Aux Transmitter On Freq 94.9. 
 
2nd event: 
Event Type: Relay 
Active: Yes 
Timed type: Sunday 
Time: 9:30:00 PM 
Relay: Aux Transmitter Off. 
 
Timed Event Mute or Unmute  
 
This is used to mute or unmute paging and alarms. (i.e. This can be used to mute AM daytimers over night . 
(event 3) and mute the audio monitoring at 6pm and event 6 re-enables monitoring 6am the next day 



  
 
Timed Event Print or Email Report(s)  

 
 
Used to print or send a report via email. 
Report Name 
 The name of the report generated by the Report Generator. 
Email Group 
 The Paging Group to send the report to. 
Action 
 If print is selected, then the report will be sent to the 
default printer. If email is selected, the report will be emailed. 
 
Timed Event Checking In 
 
 



 
 
A checking in page is used to report an analog channel once a day, week, or month to someone via email or pager. This 
can be used to report the output power of the transmitter to the engineer. A typical page would be "Site:WKBB . 
Forward Power is at 100.5 %. Thanks" 
 
Channel to report 
 The analog channel to report when emailing or paging. 
Paging Group  
The Paging Group to send the page to. 
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EAS Receivers  
 
Setting Up EAS Ports 

 

 
 
Name 
The Name of the EAS receiver. This is used to identify the receiver that received the message. 
Type 
Telnet or COM port.  A telnet converter like Site Player can be used to connect your EAS receiver to The Studio Hawk. 
If a COM Port is used, select COM port. A USB to serial adaptor can be used to add COM ports to your computer. 
Address 
If a Site Player is used, input the IP address of the Site Player. If a COM port is used, this will be ignored.  
Telnet Port/COM Port 
For a Site Player, input the port number (i.e. 23).  If a COM port is used, input the number of the COM port assigned by 
Windows. 
Baud Rate 
The baud rate your receiver has been set to.  (COM port only) 
 If a Site Player is used, you must set the baud rate within the Site Player. 
 
Note: 
The Sage ENDEC is the only EAS receiver supported now.  
 
Setting Up an EAS Receiver 
1. You will need to define a COM port on your EAS receiver as a printer. 
2. Select a baud rate on the defined COM port and make a note of it, in order to use it in setting up the EAS COM Port 
(#4 below). 
3. Interconnect the EAS receiver to your computer with a null modem cable. 
4. Setup the EAS COM port within The Studio Hawk. 
5. Shut down and restart The Studio Hawk. 
6. Perform a printer test or reboot your EAS receiver (Causing your EAS receiver to send a message to the printer port 
so that The Studio Hawk will log it) 



7. Using the menu bar, select View > EAS to see the message sent by the EAS receiver. 
 
 
Setting up The Studio Hawk to Send an EAS Message 
 

 
 
 
1.  Select Edit >Status from the menu bar. 
2.  Select a status channel that is not being used.  
Note: a total of 8 status channels are allowed.  This can be 6 I/O inputs and 2 EAS receivers or any other combination 
that equals 8. 
3.  Label the status channel like the one in the above example, “Status edit”. 
4.  Select  “Is This a EAS device”, Alarm Log Active, Paging Information Active. 
5.  Set Alarm State to On. 
6.  Select the Paging Group that you want to receive the message from the drop down menu. 
7.  Set the Number of Attempts to the number of contacts found in the Paging Group. 
8.  The information in the Quick Message” box will be replaced by the EAS message received. 
9.  Close Status Edit screen. 
10.  Perform a printer test or reboot your EAS receiver. 
11.  If the rules are not set to filter out a printer test or a system startup, the message received will be sent out in the 
form of an email or text message.  The alarm will also be logged in the alarm log. 



Setting up EAS Receiver Rules 
 
 

 
 

Rules Overview:  To prevent unwanted or unimportant messages like Startup, Printer Test, Snow Flurry Alert, etc. 
from being sent out, use the EAS Rules to filter these events out.  All messages received will be logged, but the 
rules will prevent these items from being sent out as an email or text message. 

 
1. Select “If line” 
2. Type in the phrase to be filtered 
3. Select “Then” statement (Purge Message or Delete Line) 
4. Select “Add Line”  
5. Repeat the above to add more rules  
6. Select “Save Rules” 
 
Deleting a Rule 
 

 
 
To delete a rule, highlight it and hit the backspace key.  Then select “Save Rules” to save your changes. 
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System Setup 
 

 
  
Town 
Normally used to display the city and state of the station.  
Station 
This is  used to identify the site on pages, text messages and emails.  
Simulate Mode  
Places The Studio Hawk in the simulate mode for demos and to check macros and paging without hardware attached.  
If hardware is attached the hardware is ignored (no polling is done). 
Load Carrier Pigeon on Startup (Email)  
Carrier Pigeon is the program designed to run with The Studio Hawk to enable email communication. 
Delete Trend and Collected Data After ____ Months  



The amount of time in months that The Studio Hawk will store all collected data (i.e. trend chart data, alarm data, 
analog and status data). On the first day of the month, The Studio Hawk deletes files that exceed that period of time 
(i.e. if you set this for 6 months, The Studio Hawk deletes January's data on July 1st).  
 

  
  
 Timing Tab  

Screen Update Rate  
The rate (in milliseconds) that the screen is updated.  Normally it is set to 500 ms.  It can be set 
higher on slower computers.  

Data Write Rate  
The rate in seconds to store a sample of the incoming analog and status data to the database file.  

Sample Rate  
The rate the hardware is sampled in milliseconds.  

 
Alarm relay tab 
   Use Alarm Relay  

If this box is checked and a signaling device is attached to Plus Sine, then this channel will 
activate an audible or visible alarm. For more information on signaling devices see Setting 
up Signaling Devices.  

Alarm On Relay  
The relay used to activate a signaling device.  

Alarm Off Relay  
The relay used to deactivate a signaling device.  

  Avg Count 
Average Count:  the number of samples taken by the a/d converter.  The averaging of these 
samples allows the audio metering to display the average value not the peak value. 

 
Combine Pages  

If this box is checked, The Studio Hawk combines all pages or emails within the amount of time 
specified. This is useful during the catastrophic failures when several pages or emails cue up quickly. 
(i.e. If a page or email is to be sent at 8:10 and one is to be sent at 8:12 and the combined page time is 
set to 300 seconds (5 minutes) then the two pages will be combined.)  
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Configuring and Selecting Carrier Pigeon (to enable emailing) 
 
1. Select Edit  > System and check “Load Carrier Pigeon on startup (email)”.   
 

 
 

2. If Carrier Pigeon was not checked, check it, then save and exit The Studio Hawk.  Restart The Studio Hawk, and you 
should see the Carrier Pigeon on the system tray as shown below:   
 

  
 
3. Right click on the icon and select “Open” 

4. Select “Setup” to get to the screen below: 
 

  
   
 

To setup your e-mail account: 
You will need the following information from your Internet service provider (ISP) or local area network (LAN) 
administrator.  This is the same information that is used for Outlook and Outlook Express. 
 
Authentication 
Specifies that you must log on to your outgoing e-mail server 



Use Dialup:  
Specifies that Carrier Pigeon will use an RAS account to dialup via a phone line to your ISP for a connection to the 
Internet  
Mail server   
The name of the mail server given to you by your ISP, i.e. Mail.YourDomain.com   
From Name   
The name that will appear in the incoming email or text message, i.e. WZZZ site 
User    
The user name given to you by your ISP to allow access to the outgoing mail server 
Password 
The password given to you by your ISP to allow access to the outgoing mail server 
Return address  
The address that will appear on sent emails and where returned emails will be sent 
Logging level (0=none 3=all)  
The level of logging shown in the event log:  0 for none up to 3 for full logging of communications between the mail 
server and Carrier Pigeon 
File Path 
The path where outgoing emails are stored.  Carrier Pigeon will monitor the folder.  All files that are properly formatted 
will be processed. 
 
If you do not have a high-speed connection at your site, and you are using a dialup account, you will need to setup 
“RAS” (Remote Access Server).  To activate the RAS, check “Use Dialup” on the Setup Tab. (See Setting Up RAS 
below) 
 
 
5.  To Check Carrier Pigeon 
 
Enter a valid email address in the “To” Field the select “Send Test Email”. We also suggest you send a text message to 
your cell phone via email, so you can confirm you are getting the email.  If the message is sent and accepted by the 
mail server, you will see a dialog box that states “the test email was sent”.  This takes 3-5 seconds in most cases. You 
can monitor the progress of the email by selecting  View > Event log from the Menu bar of Carrier Pigeon. 
 

 
 



 
Here is a sample Event Log from Carrier Pigeon 
 
5/13/2008  7:19:10 AM  To address.... YourAddress@SomeDomain.com, 
5/13/2008  7:19:10 AM  Subject.......  Site [WCPC] Fwd Power (sine) was logged at 0 below limit of 15 Kw for a period 
of  20 Min(s) and 31 Sec(s).. [3 of 3]. 
5/13/2008  7:19:10 AM  Body............Sent @:5/13/2008 7:18:04 AM 
5/13/2008  7:19:10 AM  cc.............. 
5/13/2008  7:19:10 AM     Resolving hostname mail.fixmystation.com. 
5/13/2008  7:19:10 AM     Connecting to 66.128.60.12. 
5/13/2008  7:19:10 AM     Connected. 
5/13/2008  7:19:10 AM  SMTP Connected 
5/13/2008  7:19:13 AM  SMPT Start begin point 0 
5/13/2008  7:19:13 AM     Encoding text 
5/13/2008  7:19:13 AM  SMPT Start point 29 
5/13/2008  7:19:13 AM  SMPT Work ended  
5/13/2008  7:19:13 AM  Message Sent 
5/13/2008  7:19:13 AM     Disconnecting. 
5/13/2008  7:19:13 AM  SMTP Disconnected 
5/13/2008  7:19:13 AM     Disconnected. 
5/13/2008  7:19:14 AM  Trying to send mail. 
5/13/2008  7:19:14 AM  +++++++++++++++++++++++++++++++ 
 
Any Error will be recorded in the event log. 
 
The most common errors are: 

1. Host not found (your server is invalid) 
2. Could not authenticate (incorrect user and/or password) 
3. Relay denied (the provider of your high speed connection will not relay the message to another mail server.  

You will need to use the outgoing mail server of your high speed provider or have relays activated by the ISP 
that is providing your mail service.   
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Relay Installation 
 
Building a Buffer to Drive Relays 

 
 
Here is a circuit to drive 5 relays. You can vary the number of components based on your application  
 
Parts List 

Quantity Part Number  Description  
5 PUT312 HSR312S  
5 Resistor  120 ohm ¼ watt  
1 Bread board   
1 Terminal Block   
    
    
    
    
    
    
    
    
    
    
    
    



    
    
    
    
    

 
 
Using a CIO-ERB08 to Drive Relays 
 
 
   More Info CIO-ERB08 
 
This relay board is available from Measurement Computing and contains buffers to allow direct connection to the 
1208SL. You will need a cable and 5 VDC power.  The power for this board is supplied from your computer with the 
supplied cable.  
 
http://www.measurementcomputing.com/PDFManuals/CIO-ERB08.pdf 

 

 
1208LS CIO-ERB08 

21 relay 1 Pin 29 

22 relay 2 Pin 28 

23 relay 3  Pin 27 

24 relay 4 Pin 26 

25 relay 5 Pin 25 

26 relay 7  Pin 24 

27 relay 7 Pin 23 

28 relay 8 Pin 22 

29 Ground Pin 21 Ground 

  

  

  

  

  

  
  
  



 


